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Getting Started with 
Smeadlink Loan 
Document Management 
(LDM) 

Introduction to Smeadlink LDM  
In the lending paper chase, it’s timing and teamwork that puts the winners in the lead 
position.  The ability to save personnel time and increase the efficiency of managing 
loan information gives your team a distinct advantage over your competition. 

Smeadlink Loan Document Management (LDM) gives you complete control over all 
documents, both paper and electronic, used throughout the life of a loan.  From 
origination through processing, underwriting, servicing, archiving and eventual 
destruction, Smeadlink LDM puts your team a step ahead of the rest.   

Smeadlink LDM is powered by “Smeadlink Express” technology, and has been pre-
configured to meet the specific needs and requirements of the Loan Processing 
industry.  Smeadlink LDM was specifically designed to efficiently manage the creation, 
use, storage, and destruction of loan files, whether in paper or electronic form. 

The following Smeadlink LDM features will increase the productivity of your loan 
processing environment: 

Express Workflow for Smeadlink LDM 
Loan Document Routing and Reporting 

• Route paper and electronic loan files through a set of structured processing 
activities, required to make a loan file complete. 

Chapter 
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• Queue up loan files which require documents to be completed at a specific 
workstation. 

• Report the processing activity of your entire loan processing department, 
individual loan processors, and specific loan files. 

Deficiency Tracking 

• Track which loan documents have been completed. 

• Report on missing loan documents required to make a loan file complete. 

• Report missing information required to make a loan document complete. 

• Track compliance dates on required loan documents. 

• Ensure compliance, by reporting loan documents which are approaching their 
required due dates. 

 

File Room Management 
Color Labeling of Paper Loan Files 

• Reduce or eliminate misfiles in the loan vault of loan filing area. 

• Reduce the time it takes to pull and refile paper loan files. 

Bar Code Tracking 

• Track the current location of all paper loan files that have been removed from the 
loan vault or loan filing area. 

• Reduce the time it takes to locate files that have been removed from the loan vault 
or loan filing area. 

• Reduce the number of “lost” loan files in your organization. 

• Enable loan processing personnel to transfer the custody of a loan file to another 
employee. 
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Requestor Management 

• Enable loan processing personnel to request paper loan files from their Desktop 
PC. 

• Enable file room personnel to fulfill loan file requests in a more efficient and 
effective manner. 

Retention Management of Paper Loan Files 

• Reduce storage costs of the loan filing area by managing the process of 
moving inactive loan file records to less costly inactive file storage space. 

• Reduce storage costs of the loan filing area by managing the process of loan 
file destruction, based on operational and legal record keeping requirements. 

• Reduce the legal risk of your organization. 

 

Electronic Record Keeping 
Desktop File Management 

• Save and Organize Desktop files to specific loan files, for future retrieval. 

• Save Desktop files as business records for your organization. 

• Share Desktop files to other loan processing personnel. 

Desktop Email Management 

• Save and Organize Emails and Email attachments to specific loan files, for 
future retrieval. 

• Save Emails as business records for your organization. 

Document Imaging 

• Improve customer service and employee productivity by enabling employees 
to retrieve and view loan documents from their Desktop PC. 

• Enable users to remotely view loan documents from a Web Browser. 

• Enable users to distribute loan documents via. CD. 
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• Reduce storage space requirements and retrieval time of active and inactive 
loan files, by storing and maintaining them in electronic form. 

Retention Management for Electronic Files 

• Reduce server storage costs of the loan filing area by managing the process of 
electronic loan file destruction, based on operational and legal record keeping 
requirements. 

• Reduce the legal risk of your organization. 

Smeadlink Express 
As mentioned previously, Smeadlink LDM is powered by Smeadlink Express 
technology.  Smeadlink Express is recordkeeping software that gives you complete 
control over all documents, both paper and electronic, used throughout your 
organization.  Bringing together document management and records management, 
Smeadlink Express offers a complete recordkeeping solution to manage the document 
life cycle according to best business practices. Developed by Smead, an industry leader 
in organization for over 95 years, Smeadlink Express puts information where you need 
it, when you need it. 

Traditionally defined as the management of paper records, records management is the 
management of the complete lifecycle of records.  Records Management focuses on 
classifying records based on business value and content.  Retention periods are applied 
to ensure documents are kept throughout their useful and legal lifecycle and destroyed 
when they are no longer required.  The focus of records management is the reduction 
of paper storage requirements and file access improvement. 

With the introduction of the computer age came the need to manage digital 
information.  Data and electronic document management commonly falls to the IT 
department, where data and document management systems are often employed.  
While IT departments have the appropriate systems to house digital information, they 
typically do not understand the “lifecycle” approach to the management of 
information commonly understood by the records management community. 

 The obvious “gap” between records management and document management needs 
to be filled with a recordkeeping program that manages information regardless of 
media or form. 

In addition to the records management challenges, businesses must manage the flow of 
information.  The advances in technology and the new collaborative tools have 
increased the amount of information created by businesses and desktop users.  The 
number of desktop files and e-mails are increasing at an alarming rate and must be 
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organized in order to be effectively used within an organization.   Business records, 
both paper and electronic, must be effectively managed.  This presents new challenges 
for managing information in today’s businesses. 

Cost savings, increased employee productivity and a competitive advantage have been 
the major reasons organizations purchased document management systems.  These 
reasons are as valid as ever, however, new business drivers are increasing the need for 
organizational accountability.  Regulatory compliance and the need to reduce legal risk 
are compelling organizations to manage both paper and electronic records. 

Smeadlink Express was developed to fill the “gap” between paper and electronic 
records management.  The concept of paper and electronic recordkeeping 
encompasses the above, in addition to applying the Express workflow concept to 
improve business process – the flow of information.   

 
Smeadlink Express was designed to increase the productivity of workgroups by 
providing better access to information and utilizing workflow to route information 
according to structured business processes.  Developed to ensure regulatory 
compliance, reduce legal liability and increase organizational accountability, Smeadlink 
Express supports better business decisions. 

Smeadlink Express streamlines records management.  Manual tasks of the file room 
are automated, increasing the efficiency in tracking and managing files.  

Every organization has different information needs and practices.  Smeadlink Express 
focuses on understanding the organization’s needs and building solutions with the 
necessary technologies to solve your information concerns today.  Smeadlink Express 
is an immediate solution to managing your information needs, with the capability of 
growing with you as your information management needs grow.  Understanding your 
organizational needs and best practices will help you leverage information to the best 
advantage. 

 

About This Manual 
This manual provides information about performing basic tasks in Smeadlink Loan 
Document Management (LDM).  Refer to the Administrative and User Manual’s for 
more advanced tasks.  These manuals can be found under the Help menu of 
Smeadlink LDM. 

Smeadlink LDM has been set up with sample data and a sample database 
(Express.mdb).  Depending on your set up, you may be using a database under a 
different name. 
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Chapter One Getting Started with Smeadlink LDM 

Chapter Two Smeadlink Express (LDM)Basics 

Chapter Three Navigating Through Smeadlink LDM 

Chapter Four Gaining Access To Your Paper & Electronic Records 

Chapter Five Filing Desktop Files 

Chapter Six Document Imaging 

Chapter Seven Remote Web Access and Publishing 

Chapter Eight File Room Management 

Chapter Nine Express Workflow for LDM 

 

“Try This” Exercises 
To become familiar with the basic functions of Smeadlink LDM, make sure to work 
through the “Try This” sections. 

Customer Support 
If you have any questions while using this manual, resources are available:  Call Smead 
Software Support at (800) 800-6131. 

 

Registration  
Your Smeadlink LDM software was registered with Smead before it was shipped.  So 
that Smead can provide you with the highest quality software, technical support, and 
inform you of new features, be sure to keep your maintenance contract current.  If you 
have any questions regarding your current registration and service contract, contact 
your local reseller or call Smead Software Support at (800) 800-6131. 
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Smeadlink LDM Solutions 
Smeadlink LDM solutions are available technologies that help your organization 
quickly file and locate and information.  Any combination of the technologies may be 
enabled in your solution.  Brief descriptions of each solution are provided below.    

 
Color Labeling  
Color Labeling enables users to print and apply color labels to the end tabs of file 
folders.  Color bands are assigned to the numbers or letters used for determining the 
filing arrangement.  Color bands can also be used to determine document types or 
other classification methods. 

Color labeling creates a color pattern on the folders in your filing area, which provides 
the following two advantages: 

• The use of color patterns enables the user to quickly and easily locate files, thus 
decreasing the time it takes to retrieve or re-file files. 

• The color filing pattern is broken when a file is placed in the wrong location 
on the filing shelf.  Because of the broken color pattern, misfiled files can easily 
be identified and placed in the right filing location.  When using color labels, 
the user can easily conduct a visual audit to determine whether any breaks in 
the color pattern exit, then re-file as necessary. 

According to ARMA (Association of Records Managers and Administrators) 
approximately 3% - 5 % of all files are filed incorrectly, making it costly and time 
consuming to locate or replace important files. 

Color labeling reduces the cost of your file storage and retrieval by: 

• Reducing the time it takes to retrieve and re-file active loan files. 

• Reducing or eliminating valuable employee time used for locating misfiled loan 
files. 

• Reducing or eliminating employee time and material costs of recreating lost 
loan files. 

• Reduce labor and material expense for labeling loan files. 

 

Bar Code Tracking  
Bar Code Tracking enables users to quickly determine the current location of paper 
loan files and documents by performing a check-in/check-out activity when files or 
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documents move from one location to another. Bar code tracking is used to track loan 
files and documents to locations, employees and boxes.  System user’s can quickly view 
the current location of a file as well as view tracking history information.  Tracking can 
also be done at the document level.  Documents can be tracked to loan files, 
employees or boxes. 

Bar Code Tracking provides the following benefits to an organization: 

• Reduce the number of missing or lost loan files. 

• Decrease the time it takes for employees to locate loan files. 

• Increase employee productivity by enabling employees to quickly locate files 
and documents, whether loan files are located in the file room or checked out 
to another employee. 

• Improve security and provide greater control of loan files from the central 
filing area.   

 
Electronic Recordkeeping (Document Imaging, PC Files & Retention Management) 
Document imaging is the process of converting and indexing paper files into electronic 
documents for future retrieval in order to provide users with fast, on-line access to 
important document information.  PC Files is the process of saving and indexing 
desktop files, such as Microsoft Word or e-mails, into a recordkeeping system for 
future retrieval.   

 Electronic recordkeeping increases productivity and reduces costs in the following 
ways: 

• Improve access to loan documents - Personnel are able to gain instantaneous, 
simultaneous, and remote access to loan documents. 

• Reduce paper file management time – Reduce the time it takes to assemble, 
retrieve, re-file, and maintain loan documents. 

• Reduce space requirements - Costly active file storage space requirements can 
be reduced by scanning loan documents for file access, then shipping the 
paper documents to a less expensive storage area. 

• Reduce inactive loan file requests – Reduce requests for time consuming and 
costly inactive file retrievals by providing on-line access to loan documents. 
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Retention Management  
Retention management enables a business to reduce costs and reduce legal risk by 
managing the life cycle of loans through their creation, use, storage and destruction.  
Retention Management ensures loan files are moved efficiently and consistently from 
more expensive active filing space to less expensive inactive filing, and eventually to 
destruction, based on the legal and useful life.  

Every organization has unique needs and business purposes.  However, the 
importance of records management remains the same, as well as some key theories of 
records management:  Information must be managed from creation to disposition 
(document lifecycle).  Information must be managed by value, not by media.   

Requestor  
Smeadlink LDM Requestor reduces the costs of your paper filing system and increases 
employee productivity by reducing the retrieval time of loan files from the filing area.  
Users can request paper files directly from their PC and file rooms can fulfill requests 
more efficiently. 

iAccess 
iAccess provides remote access to electronic records from any a web browser. 

iPublish  
iPublish provides users with the ability to publish electronic records to CD for 
distribution.  The distributed CD can then be viewed from any web browser.    
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Smeadlink Express Basics 

Installing Smeadlink Loan Document Management 
(LDM) 
Installation Steps 

• Insert the Smeadlink CD into your CD drive. 
• At the Smeadlink Installation Screen, Choose “Smeadlink  Express 

Application Setup.” 
• Follow the instructions as they appear on your screen. 

 
Hint:  As the installation proceeds, you won’t need to do much other than 

okay the default settings. You will need to enter your CD serial number and registration code 
when prompted – this can be found on the documentation that came with the software.  Use 
DEMO as the serial number and registration code if this installation is for demonstration 
purposes. 
 
The entire installation will take just a few moments.  You will be asked to restart 
your system when installation is complete. Once you restart, you will see the 
Smeadlink Installation Screen again. If you don’t already have Adobe Acrobat 
Reader installed on your system, you can choose to install it now. Or, you can 
click “Exit,” and locate the Smeadlink icon on the desktop.   
 

Hint:  Adobe Acrobat Reader is necessary to access the Smeadlink LDM User 
and System Manuals. 

 
Congratulations!  You’ve successfully installed your new Smeadlink Loan 
Document Management software, powered by Smeadlink Express! 

 

 

Chapter 
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Logging On  

• Double-click the Smeadlink icon on your desktop. 
• A startup screen will now appear, allowing you to open the desired 

Smeadlink Express database and your login and password.  
• Select Loan Files.mdb from the available choices.  If Loan Files.mdb is 

not available, double-click More Files, then select the Loan Files.mdb file 
from the C:\Program Files\Smeadlink\Data directory. 

• Log in as “Manager.” The default password is also “Manager.”  
 
 

 
Smeadlink LDM Login Screen 

 

Hint:  If the Loan Files.mdb file does not appear as an available option, double-
click on “More Files.”  Navigate to the location of the Loan Files.mdb file.  The default 
location is as follows:  C:\Program Files\Smeadlink\Loan Files.mdb. 

The “Manager” login will give you full access to all end user, file room user, and 
administrative features of Smeadlink Loan Document Management.  If you want to 
change your password before you begin, refer to the Systems Administrator Guide 
located under the Help menu.   Available logins and passwords are as follows: 

Manager, Manager – Full access to all Smeadlink LDM features 

Editor, Editor – Edit, tracking, and indexing for the Records Workgroup 

Guest, Guest – Viewing rights to the Loan Processing Workgroup 
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Logging In 

• Select the Loan Files.mdb database file from the available databases.   

• Login using “Manager” as the Name and the Password. 

“Manager”access rights gives full privileges for each workgroup and all data tables. 

 

Navigation Bar 
The navigation bar contains bars and icons.  Each bar represents a workgroup or 
group of tables used by a workgroup, to perform their work tasks.  Each icon, within a 
workgroup represents a table within Smeadlink LDM.  Position the pointer over an 
icon.  The icon function will appear.  Click the Icon to open the table and begin your 
document search. 

 
 

Try This:   

� 
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Navigating Through 
Smeadlink LDM 

Workgroups and Tables 
To begin your information search, select a Workgroup from the Navigation Bar on the 
left and select an available table within the selected Workgroup. 

A Workgroup is a group of related tables that work together to perform a business 
function for a single department or employee workgroup.  Tables within a Workgroup 
are also referred to as Folders. 

 

Hint:  Upon startup, the Records Workgroup is automatically selected for you.   

 
 
 

 
Startup screen with Records Workgroup selected 

 

Chapter 
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Query (Finding your records) 
 
After selecting a table, a Query window will display.  Enter your search criteria into the 
Query window, then hit the Enter key or Select the Apply Query button. 

 

 

Hint:  To view all records for the selected table, do not enter search criteria.  
Simply hit the Enter key. 

Hint:  Use wild cards (* or ?) to expand your search.  Place “ * ” before or after 
your search criteria to allow any number of characters to proceed or follow your 
entered search text.  Type “ ? ”  to replace any single character within your search text. 

 

Record Search 

• Enter “Clark*” into the Customer Name field, then hit the Enter key, in order to 
display all Customers that begin with “Clark”. 

All Customer records beginning with “Clark” will display. 

 

Selecting Records  
A record must first be selected before any action can take place on the record.  To 
select a record, click on the box to the left of the record.  Once selected, the record will 
become highlighted in blue. 

Try This:   

� 
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Hint:  A record can be selected by placing the cursor anywhere on the record.  To 
select multiple records, hold down the Control key while you select each record. 

 

Related Tables   
Related tables are tables whose data or information is associated to the table you are 
currently viewing.  For example, the Loans table is related to the Customers table.  
Because of this table relationship, a user will be able to locate a Customer and view all 
Loan records associated to the selected Customer. 

To select a related table, click on a blue hyperlink located above or below the table you 
are currently viewing.  Hyperlinks will become available if another table is related to the 
current, active table.  A table may have more than one related table.    Hyperlinks will 
be blue if there is available data for the selected record. 

 

Using Loans Hyperlinks 

• Select the “Linda Clark” Customer record. 

• Select the Loans hyperlink at the bottom of the screen to view all Loans associated 
to Linda Clark’s Customer record.   

• Linda Clark currently has one loan file, as displayed in the database. 

Try This:   

� 
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Using the Documents Hyperlink 

• Select the American Trust loan file, then select the Documents hyperlink to 
view all Documents associated to the selected file. 

 

  

 

 

Try This:  

� 
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Navigating with Hyperlinks 

• Return to the Loans table by selecting the Loans hyperlink above the current 
Documents table. 

• Return to the Customers table by selecting the Customers hyperlink above 
the Loans table. 

 

Accessing Tables Directly 
Tables can also be directly accessed from the Navigation Bar.  When tables are selected 
directly from the Navigation Bar, all records from that table are available for search.  
When accessing related tables through a hyperlink, the related table will only display 
data associated to the selected record.  For example, to view all Loan files, select the 
Loans table from the Navigation Bar.  To view all Loan files for a specific Customer, 
select the Customers table.  Locate the desired Customer record and select the Loans 
hyperlink. 

 

Accessing Tables 

• Select the Loans table from the Navigation Bar. 

• Enter “186-14-50” into the Loan Number field; Hit the Enter key to view the 
record representing the selected Loan file. 

• Select the Loans table again, and select “Commercial Loans” from the Loan 
Type field, then hit Enter to view a list of all Commercial Loan files. 

 

Form View and Grid View 
Smeadlink LDM supports both Grid View and Form View mode.   

Grid View mode enables the user to view a list of records matching the users search 
criteria.  Form View mode will display one record at a time, but will enable the user to 
see more fields for the selected record. 

Try This:   

� 

Try This: 

� 
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To change from the default Grid (list) View to Form View, select “Switch to Form 
View” from the View menu.  To switch back, select “Switch to Grid View” from the 
same menu.   

 

 

Printing a Report 
Reports are printed by selecting the Print button at the top of the screen.  Reports can 
be printed in either Grid Style or Formatted Report Style. 

 

 

Grid Reports list all records currently viewed in the Grid.  The Grid Report will retain 
the same field order and sort order as the current Grid View. 

Formatted Reports are Grid reports including the following information: 

• Headers and Footers 

• Related table information - For example, a list of Loan files with their 
current tracked location, or a Customer list that includes each active 
Loan. 
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Adding Records 
Records are added to the Smeadlink LDM database by selecting the New button at the 
top of the screen.  A user must have “Add” privileges before records can be added. 

After selecting the New button, the user will be prompted to enter all available fields 
for the current table.  To save the record: 

• Hit the Return or Enter key to Save and Clear.  This feature enables users 
to efficiently enter many Customer or Loan records into the table during 
the same data entry session 

– OR- 

• Select the Save and Exit button with the mouse, to save the new record 
to the database table, then return to the screen. 

 

Hint:  New records can be added to a table, whether the table is accessed directly 
from the Navigation Bar or whether the table is accessed from an associated table as a 
related table. 

 

 
 
 

 
 

Add a New Customer 

• Select the Customers table from the Records Workgroup 

• Hit the Enter key to display all records 

• Select the New button, add the following information, then select the Save 
and Exit button: 

Try This: 

� 
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Account # = 123456789 

Customer Name = Doe, John 

SSN = 555555555 

 

 

Add a New Loan file for John Doe 

• Select the newly created Customer Record of John Doe. 

• Select the Loans hyperlink.  An empty Loan table will display, because no 
Loan files have been assigned to John. 

• Select the New button and add the following information: 

Loan No. = 123456789 

Loan Type = Select “Commercial Loan” (CML) 

Loan Description = John’s Restaurant 

Date Opened = 10/01/02 

Leave the other fields blank. 

Note:  The Date Due field will auto populated, based on pre-determined 
workflow scheduling requirements, if left blank. 

Try This: 

� 
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Hint:  When entering Loan information as a related table to Customers, the user 
will not be prompted to enter the Customer # or Customer Name, as they will be 
auto- filled. 

 

Add a New Folder as a Direct Table 
 

• Select the Loans table from the Navigation Bar. 

• Hit the Enter key to display all Loan records. 

• Select the New button. 

• Enter the following information into the Add prompt box: 

Loan No. = 123456788 

Loan Type = Select “Auto Loan” (Auto) 

Loan Description = 2002 Harley 

Account No. = 123456789 

Date Opened = 6/4/02 

Leave the other fields blank. 

Try This: 

� 
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Note:  The Customer field will be auto-filled, because you have entered the Customer’s 
Account No. 

 

 

• Select the Customers table and locate John Doe’s record. 

• Select the Loans hyperlink to display the two new Loan files for John Doe. 

 

Hint:  When adding a new Loan, the user must specify to which Customer the 
Loan file belongs.  This can be done by entering the Account # or by using the 
Customer lookup field, which allows the user to select from a list of valid Customers. 
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Editing Records 
The Edit feature enables authorized users to make changes to the data in the Grid or 
Form View.  To edit a record, simply navigate to the record and make the necessary 
changes to the data.  The following limitations apply: 

• Text Fields – The user can edit data in all text fields, unless the field has been defined 
as non-editable. 

• Lookup Fields – The user can change the selection on all Lookup fields, unless the 
field has been defined as non-editable. 

• Auto Assigned Fields – The user cannot make any changes to fields which are auto 
assigned by Smeadlink LDM, such as the Document Id field. 

 

Deleting Records 
The Delete feature enables authorized users to delete records from the Smeadlink 
LDM database.  If a record you are trying to delete has related data, tracking data, or 
electronic document attachments, the user will be warned of the existing Child Records 
before continuing the deletion.  For example, while deleting a Customer who has 
existing loan files, the user will be prompted that existing loan files exist. 

To delete a record, simply select the record and hit the Delete key on your keyboard. 
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Gaining Access to your Paper 
& Electronic Records  

Viewing Electronic Records 
Loan Processing Personnel and other workgroup users can store and retrieve 
electronic records from their desktop using Smeadlink LDM.  Electronic records are 
stored as document attachments.  After selecting the record identifying the document, 
select the Attachments button to view the electronic document(s). When a record has 
documents assigned to it, the Attachments button will become enabled. 

The following Electronic document types are supported in Smeadlink LDM: 

Scanned images of paper documents (Document Imaging) 

Microsoft Office files (Word, Excel, and Outlook) 

E-mail messages and email attachments 

Native PC Files (all other PC created file types are supported, but they will be 
opened by native program) 

 

Viewing Scanned Documents 
Scanned documents are typically saved into Smeadlink LDM as a TIFF file type.  TIFF 
documents are displayed directly in the Document Viewer.  Once viewed, the user can 
navigate to each page or view other versions, by selecting the green arrow keys in the 
Document Viewer toolbar.   

 

Chapter 
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If the Document Viewer displays a Word, Excel, or other PC created file type, the user 
will need to click on the icon of the document to open the electronic document and 
launch the native application or viewer, required to read the selected file type.  
Depending on the editing privileges of the user, there will be up to three access 
methods: 

• Click on the Icon to open the document in Read Only mode.  This method will 
enable the user to view the document, but will not allow any changes to be made to the 
document.  Most users will have this type of access right. 

• Edit in Place – This method enables the user to make changes to the electronic 
document. 

• Edit New Version – This method enables the user to open the document in read 
only mode, but also gives the user the ability to make changes to a copy (a new version) 
of the existing electronic document. The next time the document is retrieved by a user, 
they will view the newest version. 

 

 

 

View an Attachment 

• Select Loan Number 186-14-50 (American Trust) from the Loans table. 

• Navigate to the Documents table, using the Documents hyperlink. 

• Select the Drivers License record. 

Try This:   

� 
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• Select the Attachments button.  The Document Viewer will open and display Linda 
Clark’s Drivers License. 

• Close the Document Viewer by selecting the “X” at the upper right corner. 

 

Viewing the Current Status of a Physical File 
Smeadlink LDM enables users to quickly and easily view the current location of a 
physical file, by displaying the current location status at the bottom of the screen.  If 
the table you are currently viewing has file tracking information associated with it, the 
tracking viewer will automatically display at the bottom of the screen. 

 

 

 

By expanding the tracking viewer, the user can also view the current requestor status of 
a file and run a tracking history report.  To view a file’s tracking history report, right-
click on the Loans line of the tracking viewer, then select History. 

 

 

 

View Tracking History 

• Select the Loans table from the Navigation Bar. 

• Locate Loan Number 186-14-50 and view the current location, requestor status 
and tracking history of the American Trust loan file.  The American Trust loan file 
should currently reside in the Central File Room. 

 

Try This:   
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Requesting a Physical File 
Smeadlink LDM users can easily request loan files from the loan vault or other 
centralized or de-centralized filing areas by selecting a loan file in the Loans table, then 
pressing the Request button.  A Requestor popup box will display, prompting the user 
to select their name, from the list of employees, and select the priority of the request.  

 

 

Requestor Options  
• The Requestor feature can be turned off. 
• The Wait List feature can be turned off. 
• The Name of the Requesting person can auto fill, based on the User Name 

given at the time of log on. 
• Users can be restricted from using High Priority. 
 

Hint:  Only current loan files residing in a filing area can be requested.  If the user 
requests a loan file that is checked out to another employee, a message will display 
stating the file is not available.  The user will then be asked whether they would like to 
reserve the loan file for future delivery by being added to the Wait List.   

 

Request the American Trust loan file from the file room 

• Select the American Trust loan record. 

• Select the Request button, then select OK. 

• Jeffrey Cox will be the default requesting person.  

You have successfully requested a file.  If the file is currently checked out to another 
employee, you will be told the file is not available and be asked whether or not you 
would like to reserve the file for future delivery. 

Try This:   
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Transferring a Physical File 
An employee can transfer the custody of a loan file by selecting a loan record, then 
pressing the Transfer button.  The user will be prompted to enter the name of the 
Destination (Employee file is going to) and the due date assigned.  

 

 

 

Transferring a Loan File 

• Transfer any loan file, currently located in the Central File Room, to Kim Cooper.  
As long as the loan is currently in the file room and has not yet been requested by 
another user, the File Transfer should be successful.   

• Next, Transfer the American Trust loan file to Kim Cooper.  Note: The Wait List 
box displays, letting you know there is another employee waiting for the file.  This 
is because you requested this file during a previous exercise. 

• Continue the transfer by selecting the Continue Transfer button.  By selecting 
Continue, you will be ignoring the previously made request for the American 
Trust loan file. 

 

Transfer Options 
• The Transfer feature can be turned off or its use can be limited to specific 

individuals. 
• The Due Date requirement only displays when the file room is requiring 

its use. 
 

Try This:   
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Filing Desktop Files  
Smeadlink LDM enables loan processing or other workgroup users to electronically 
organize their desktop files, e-mails and scanned documents by their loan numbers, for 
future retrieval.   

MS Office 2000 and XP Support 
 
Smeadlink LDM has been integrated to Microsoft Word, Excel, and Outlook email 
messages and attachments.   MS Office integration enables users to file and classify 
documents directly into the Smeadlink LDM electronic recordkeeping system for 
storage and retrieval of electronic business records. 

Whenever an existing document is opened or a new document is created in any of the 
approved MS Office applications, the file can be electronically filed by selecting the 
Smeadlink Icon on the MS Office toolbar, or by selecting “Send to Smeadlink” from 
the application’s File menu. 

 

 
Smeadlink Icon from MS Office Application Toolbar 

 
 

Chapter 
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Turning on MS Office Support  
(This must be completed at each PC.) 

Manager access rights are necessary in order to add this level of support. 
 

To turn on MS Office Support, complete the following steps at each PC: 
• Login as Manager. 
• Select Options from the Tools menu. 
• Select the MS Office Connectivity tab. 
• Select the Connect radio button for Word, Excel and Outlook. 
• Select Setup for each of the three file types and select the Do Not 

Ask Me Again checkbox, then click OK. 
• Select the Apply button on the Options screen, then click OK to 

close. 
• Open Microsoft Word. 

A Smeadlink Icon will now appear on the MS Word toolbar and the “Send To 
Smeadlink” menu item will now appear in the File menu of MS Office.  You are 
now integrated. 
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Indexing and Classifying MS Office Documents 
 
To index MS Office documents for future retrieval, select the Smeadlink Icon or select 
the Send To Smeadlink menu item, from within the MS Office application you are 
current working.  An indexing dialog box will display, requesting pre-determined 
indexing information.  Smeadlink LDM has been pre-configured to electronically file 
Loan Documents.  Loan Documents will be filed to a loan number, then to a specific 
document type, in order to make electronic file retrieval fast and efficient.  

 
 

Indexing a Loan Document 
• Create a new document, using MS Word.  Make sure to enter some text into 

the body of the message, such as, “Sample Loan Document.” 
• Select the Smeadlink Icon on the MS Word toolbar. 
• Enter the following information into the indexing dialog box:   

Loan Number = “123456789”, then hit Enter. 
 

 
 
• You will now be prompted to verify you are indexing the document to the 

correct electronic loan file. 
 
 
 
 

Try This: 
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• Select the Misc. Document Type; Hit Enter. 
 

 
 
 
You have now successfully, electronically filed a MS Word document into 
Smeadlink LDM. 
 
Retrieve a Loan Document 
 
• Retrieve the saved Word document by locating Loan Number 123456789 

from the Loans table. 
• Select the Documents hyperlink. 
• Select the Application for Loan document type. 
• Open the Document Viewer by selecting the Attachments button. 

 
 

Hint:  The user also has the ability to save documents to loan files that are not 
currently entered into the Loans table.  When entering a new Loan record, the 
indexing dialog will prompt the user to enter the Account # and other required 
fields. 
 
 
 
 
 
 

Other PC File Types 
Smeadlink LDM enables users to electronically file any PC created file type for 
organized and efficient storage, indexing and retrieval.   
 

Try This: 
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Non MS Office electronic documents can be indexed into Smeadlink LDM using 
one of the following two methods: 
 

• Drag a desktop file onto the Smeadlink Desktop Icon – Simply drag a file you 
wish to save into your document management system onto the Smeadlink Icon.  
The same indexing prompt box, as with MS Office, will display, prompting the 
user to enter the required indexing information. 

 
• Attach PC File – Right-click on the record to which you want to attach the 

electronic file, then navigate to and select the file. 
 
 
 
 
 
 

• Navigate to the John’s Restaurant loan record (Loan Number 
123456789), in the Loans table. 

• Select the Documents hyperlink. 
• Right-click onto one of the document records, then select Attach PC File 

from the pop up menu. 
• Navigate to a desktop file of your choice, then click OK. 
• The file will be indexed and saved into Smeadlink LDM for future 

retrieval. 
• With the new record selected, select the Attachments button to view the 

document. 
 
 

 
• Drag and drop a file over the Smeadlink Icon on your desktop 
• The Indexing dialog box will display, providing the user with valid 

indexing criteria. 
 
 
 
 

Try This: 

� 
Try This: 
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Document Imaging 
Document Imaging is the process of scanning, indexing, and storing paper files in an 
electronic form for future retrieval, in order to provide users with fast, on-line access to 
important documents.   

Document Imaging will enable your loan processing department to increase 
productivity and reduce costs in the following ways: 

• Improve access to loan documents - Personnel are able to gain 
instantaneous, simultaneous, and remote access to loan documents. 

• Reduce paper file management time – Reduce the time it takes to 
assemble, retrieve, re-file, and maintain documents. 

• Reduce vault storage requirements - Costly active loan file storage space 
requirements are reduced by scanning documents for file access, then shipping 
the paper documents to a less expensive inactive storage area. 

• Reduce inactive file requests – Reduce requests for time consuming and 
costly inactive file retrievals by providing on-line access to documents. 

 

Image Capture and Indexing 
Smeadlink LDM was designed to enable loan processing personnel or other 
workgroup members to capture and index paper documents into an electronic 
storage and retrieval system by using one or more of the following methods: 
 

• Scan and Index loan documents at a designated scanning station (Scanning 
station requires Kofax compatible scanner and board).  This method 
normally requires a skilled scanner operator to scan batches of loan files to 
the system, for electronic storage and retrieval. 

 

Chapter 
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• Loan processing personnel can scan loan documents at a designated 
scanning area and then return to their desks to classify and index 
documents, using the Manual Indexing method. 

 
• Scan and Index loan documents from the end user’s PC (currently requires 

a Kofax compatible scanner and board). 
 

Scanning with Document Separator Sheets 
When batch scanning, loan files are normally scanned using document type bar 
code separator sheets to automate the process of identifying the document type 
for each loan document scanned.  Document Separator Sheets are inserted before 
each loan document, in order to tell the scanning system when a new document is 
about to be scanned.  Documents are then stored by their respective document 
type, making file retrieval more efficient to loan processing personnel.  Using 
document separator sheets greatly increases scanning and indexing efficiency and 
decreases ongoing retrieval time of your electronic documents.   
 
 
Print Document Separator Sheets: 

• Select the Loan Types table from the Maintenance Workgroup. 
• Hit the Enter key to display all Loan Types. 
• Select a Loan Type record, then select the Document Types hyperlink to 

display all Document Types associated with the selected Loan Type. 
• Select the Print button and choose Labels. 

 
 
 

Capture and Indexing in Smeadlink Express 
To begin scanning documents, select Scanner from the Smeadlink Go menu.  The 
Image Capture screen will now display. 
 

Hint:  In order to open the scanning window, a Smeadlink LDM compatible 
scanner and scanner hardware/software must first be installed.  Talk to your 
Smeadlink LDM reseller for more information about scanning hardware and 
software. 
 
 

Try This: 
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The Smeadlink LDM Scanning widow will now display.  To begin capturing and 
indexing documents, complete the following steps: 
 

• Select the Scanner scan rule, by selecting Scanner from the 
Scanning/Rules menu. 

 
 

 
 
 
 

• To begin scanning, select the Scan Icon from the tool bar. 
 

• As documents are captured, you will be prompted to enter the indexing 
information used to locate and identify documents for future retrieval. 
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Remote Web Access and 
Publishing 
  

iPublish  
iAccess users with the ability to distribute Loan document information via. CD. 

iPublish provides users with the ability to download a subset of your electronic 
business records and distribute them to users, via CD.  The distributed CD can 
then be viewed from any web browser.   iPublish provides users with the 
following capability: 
 

• Query available records 
• Navigate to related tables 
• View electronic documents. 

 

iAccess  
iAccess is enables loan processing personnel to view loan documents from a Web 
Browser. 

iAccess is a web enabling technology, used to provide end users with the ability to 
remotely access Smeadlink LDM via any web browser.  iAccess provides users 
with the following capabilities: 
 

• Locate a Loan file. 
• Add, Edit, and Delete Customer, Loan, and Document records. 
• View the current tracked location of a loan file. 
• Transfer a loan file to another user. 
• Request a loan file from the file room or vault. 

Chapter 
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• View electronic documents. 
 

 
Consult your Smeadlink LDM reseller for more information regarding iAccess and iPublish. 
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File Room Management 
The Smeadlink LDM File Room Manager was designed to increase the productivity of 
an organization by making files more accessible to loan processing personnel or other 
workgroup end users.  By reducing the time it takes to locate and deliver paper loan 
files from the filing area, Workgroup end users can become more productive.  Proper 
file room management techniques will ensure the following benefits to an organization: 

• Reduce misfiles in the filing area with the use of color coded filing. 

• Easily locate loan files checked out of the filing area, using Bar Code 
Tracking. 

• Efficiently manage loan file requests to the loan vault. 

• Manage loan file request Exceptions 

• Reduce costly loan vault storage costs by managing the movement of 
inactive files to less costly inactive file storage space. 

• Reduce legal liability by managing retention for records destruction or vital 
record preservation. 

 

Color Labeling 
Color Labeling enables file room personnel to print and apply color labels to the end 
tabs of loan folders.  Color bands are assigned to the numbers or letters used for 
determining the filing arrangement.  Color bands can also be used to determine loan 
types or loan officers. 

Color labeling creates a color pattern, providing the following advantages: 

• The use of color patterns enables the user to quickly and easily locate files, thus 
decreasing the time it takes to retrieve or re-file files. 

Chapter Chapter 
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• The color filing pattern is broken when a loan file is placed in the wrong 
location on the filing shelf.  Because of the broken color pattern, misfiles are 
easily identified and placed in the right filing location.  When using color labels, 
the user can easily conduct a visual audit to determine whether any breaks in 
the color pattern exist, then re-file as necessary. 

Color labeling reduces the cost of your file storage and retrieval by: 

• Reducing the time it takes to retrieve and re-file active loan files. 

• Reducing or eliminating valuable employee time used for locating misfiled files. 

• Reducing or eliminating employee time and material costs of recreating lost 
loan files. 

• Reducing the labor and material expense for labeling loan files. 

According to ARMA (Association of Records Managers and Administrators) 
approximately three to five percent of all files are filed incorrectly, making it costly and 
time consuming to locate or replace important files. 

Custom Label Designs 
Smeadlink LDM comes with a standard color label designs, however, most 
organizations find it useful to design a custom label to meet their specific filing needs.  
Talk with your Smeadlink LDM reseller for assistance in designing and implementing a 
custom label design to meet your specific loan  filing requirements. 

Printing Color Labels 
Printing a Label 
Printing labels is easy in Smeadlink LDM.  Simply locate the loan record needing a 
label.  Select the Print button and choose Label.  If a label has been designed for the 
table you are in, the Labels menu item will be enabled under the Print button. 
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Print a color label 

• Select the Loans table from the Records Workgroup. 

• Select a loan record. 

• Select the Print button; Choose Labels. 

• A Label Printing dialog box will now display.  Select the Loans label 
design. 

• Select Print to print the label. 

Hint:  The Label Printing dialog box provides the user with label printing options. 
The Stock field should be ignored when printing color labels. 

Hint:  Inkjet printers and label stock should be used if you intend to print a few 
labels at a time and reuse label stock. 

Hint:  The user can choose which label position, on the label stock, to start 
printing.  This option is useful when the user prints only a few labels at a time.  The 
user can choose label designs.  The printer can be selected by selecting the Setup 
button. 

 

  

   

Printing Multiple Labels 
Multiple labels can be printed at the same time by selecting multiple records before 
printing.  To select multiple records, hold down the CTRL key while you select each 
record to be printed.  If no records are selected, all records displayed on the grid will be 
printed. 

Try This 
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Printing a Batch of Labels 
Often, file room users may be required to print a large batch of labels.  This 
requirement may be the result of adding or importing a large number of loan files. 

 

Printing Label Batches 

While in the Loans table of the Records Workgroup: 

• Select the View menu on the main menu bar. 

• Select the Print Loan Files view. 

• A list of records will now display.  Sort the labels in the desired order. 

• Without selecting any records, select the Print button.  Choose Labels. 

• A label will now be printed for each record displayed. 

• Return to the Loans View, by selecting Loans from the View menu. 

 

Hint:  After labels have been printed, their records will be flagged as being printed 
and will no longer appear in the “To Be Printed” list in the Print Labels view.  Loan 
files are flagged as “Printed” by the check box being selected in the “Printed” field of 
each Loan record. 

 

Reprinting Batch Labels 
Labels can be re-sent to the batch print queue by simply removing the “Y” from the 
Printed field.  The next time a batch of labels is printed, the unflagged record will 
display in the print queue. 

 

  

Tracking Loan Files 
Bar Code Tracking enables users to quickly determine the current location of paper 
loan files.  In order to easily track loan files to employees, locations or boxes, bar code 

Try This 
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labels are placed on each loan file folder.  When loan files leave the filing area, the file’s 
bar code is scanned or tracked to its destination by a bar code reader.   

Bar Code Tracking is used to track files and/or documents to locations, employees and 
boxes, enabling the user to quickly view the current location of a loan file, along with 
its tracking history.   For example: 

• Paper loan files can be tracked to a File Room or Loan Vault, to an 
Employee, or to a Box. 

• Loose documents can be tracked to files or to Employees. 

 

Bar Code Tracking provides the following benefits to an organization: 

• Reduces the number of missing or lost files. 

• Decreases the time it takes for employees to locate files. 

• Increase employee productivity and decision-making by enabling users to 
quickly locate critical files and documents when they are needed, whether 
files are located in the file room or checked out to another employee. 

• Improve security, organizational accountability and provide greater control 
of paper files, which are maintained in the filing areas of an organization.   

 
 

Using the Bar Code Tracking Module 
The Smeadlink LDM Bar Code Tracking module provides file room personnel with an 
efficient and easy way to check files in and out of the filing area.  To use the Bar Code 
Tracking module, select Bar Code Tracking from the Go menu.  The Bar Code 
Tracking window will now display. 

 



S M E A D L I N K  L D M   
 

 44

 

 

The Bar Code Tracking window is used to quickly and efficiently check loan files in 
and out of the file room by the use of a bar code reader.  The user must first scan the 
location bar code, which represents the destination to which the file is going, and then 
each loan folder is scanned.  The destination can be an Employee, a File Room or 
other Location, or a Box.  The tracking system will assign each of the scanned loan 
files or documents to the destination to which it was tracked. 

 

Manually Tracking Files 
File Room personnel can manually check files in and out of the file room by manually 
selecting the destination, using the destination lookup feature, then by manually 
entering the bar code number on the folder.   

Hint:  Press the Enter key after entering each Destination and Loan file number. 

Due Dates 
If the loan file being tracked to a destination requires a due date, the date must be 
assigned before the tracking can take place.  The Due Date is often used when an 
organizational policy requires it.  For example, all files checked out to employees must 
be returned within five days.  To enter a Due Date, select the down arrow to the right 
of the Due Back Date field, then choose the date the file must be returned.  The 
selected date will remain as the default due back date for other tracking activity. 

 

Options 

The user has the option to select one of the following tracking modes: 
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Lock Destination – This option will keep the scanned or selected Destination in the 
Destination field, until the user deletes it and enters or scans a new destination bar 
code number.  This feature is useful when entering many records at one time and the 
Destination must remain the same. 

Hold Destination/Detect Change – This option is the most widely used by an 
active file room.  The Hold Destination/Detect Change option allows file room 
personnel to scan bar code labels from both Destinations and Files.  Each time a 
Destination bar code is scanned the Destination field will automatically change.  All 
files scanned after the newly scanned destination will be assigned to that new 
destination. 

Neither – This option requires the user to scan a Destination bar code before 
scanning each file.   

Due Back Date – The Due Back Date requirement can be turned on or off for each 
tracking destination by selecting or de-selecting the “Due Date” field in the tracking 
tables located in the Tracking workgroup. 

Hint:  The default scanning mode is “Hold Destination/Detect Change.” 

 

 

 

Printing Bar Code Labels 
Black and white bar code labels can be printed for Loan Folders, Documents, and 
Tracking Destinations.  Normally, color coded labels will be placed on each file folder 
in a filing area.  However, when color coding is not used, black and white bar code 
labels can be placed on each of the loan folders.  To print a black and white bar code 
label, select the record representing a file folder, document, or tracking destination, 
then select the Print button and choose Labels.  Select a black and white label design 
before printing. 
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Tracking Destinations  
(Employees, Locations, and Boxes) 

Tracking Destinations are located in the Tracking Workgroup of Smeadlink Express.  
A user must have a user login and password authorizing Tracking Workgroup access.  
The Tracking Workgroup contains the following tables: 

Employees – Listing of Employees to which Files, Documents, or Boxes can be 
tracked. 

Locations – Filing areas to which Files or Boxes can be tracked. 

Boxes – List representing boxes of inactive files tracked to an inactive filing area. 

 

Hint:  Destinations can be added by selecting the desired table, then entering the 
new destination/description.  A unique bar code will automatically be assigned to each 
tracking destination.  Be sure to select “Active” or users will not be able to track files 
to that destination.  In the Locations table, be sure to select “Requestable” if you 
want users to have the ability to request files from that specific filing area. 

Hint:  Select “Due Date” to require a due date to be entered while a Loan file is 
being tracked to that location or employee. 

 

 

Printing Bar Code Labels 

Make sure you are logged in as Manager. 

• Select the Tracking Workgroup. 

Try This:   
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• Select the Locations table; Hit Enter to view all records. 

• Select Print; Choose Labels. 

• Print all Location tables. 

• Repeat this for Employees and Boxes. 

• Enter the Loans table of the Records Workgroup; Hit Enter to view all 
records. 

• Select five loan records. 

• Select the Print button; Choose Labels. 

 

Tracking Files 

• Open the Tracking Window by selecting Bar Code Tracking from the Go 
menu. 

• Make sure Hold Destination/Detect Change is selected. 

• Scan the bar code of the Employee, Kim Cooper, as the Destination. 

• Scan a few loan files into the Object field, in order to assign these folders to 
Kim Cooper.  Scan Loan files located in the file room and have no pending 
requests. 

• Next, scan the Central File Room bar code.  Note the Central File Room’s 
bar code “L1” is now automatically placed into the Destination field. 

• Scan the same folders back into the Central file room by rescanning each Loan 
file barcode. 

   

 
Tracking Reports 
File Room personnel can run the following tracking reports: 

Files Out by Employee – Under the Reports menu when in the Employees table of 
the Tracking Workgroup. 

Try This:   
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File Inventory Report (Files Out by Location) – Under the Reports menu when in 
the Locations table of the Tracking Workgroup. 

Past Due Report – Under the Reports menu, then Tracking sub menu. 

Current Tracked Location – In the Tracking Viewer of Smeadlink LDM. 

Tracking History – Expand the Tracking Viewer of Smeadlink LDM, then right-click 
on the file number; Select History. 

Loan Files tracked to a box – Enter the Boxes table, in the Tracking Workgroup, 
select the desired box, expand the tracking viewer, then right-click on the Box and 
select “All Folders Contained in this Box.” 

Loan Files tracked to a specific location or employee – Enter the Locations or 
Employees table, in the Tracking Workgroup, select the desired record, expand the 
tracking viewer, then right-click on the Location or Employee line and select “All 
Folders Contained.” 

Boxes tracked to a specific location or employee – Enter the Locations or 
Employees table, in the Tracking Workgroup, select the desired record, expand the 
tracking viewer, then right-click on the Location or Employee line and select “All 
Boxes Contained.” 

 

Requestor Management 
Requestor Management will increase the productivity of both Workgroup users 
and File Room personnel, by increasing the efficiency of the file requesting and 
delivery process.  Workgroup users are able to request paper records from their 
desktop, while File Room personnel can print lists of requests and efficient pull 
and deliver records. 
 
The Requestor feature will enable File Room personnel to better manage current 
requests, sort requests by file room order, handle Exceptions, and track where 
records are, in the delivery process.  File Room personnel will also be alerted to 
the Wait List status of a file, when it is returned to the file room.  When a file is 
returned to the file room, the user will immediately be notified as to where there 
are any outstanding requests or reservations for the returned file.   
 
Workgroup users are able to request files from their desktop, without having to 
walk over to the file room area.  When a file is currently not available for delivery, 
the Workgroup user will be immediately notified as to the files’ current 
unavailability and also let the user know the current location and reserved status of 
the file.  The user will have the option to reserve the file for future delivery. 

 



S M E A D L I N K  L D M   
 

 49

Managing Loan File Requests 
File Room Requestor Management is managed by using the Requestor Report, 
located under the Reports menu.   
 

 
    
 
Managing Loan File Requests 
New File Requests, made by Workgroup users, will appear on the New Requests 
report, located in the Requestor Reports menu.  The New Requests report should 
be run on a periodic basis, depending on current file room activity. 
 

 
 
 
The following activities should be completed before printing and fulfilling the 
New Requests: 
 

• Sort the New Requests report in the order files are arranged on the shelf.  
To sort records, click on the column headers at the top of the report.  By 
holding down the CTRL key, the user can sort on multiple report 
columns. 

 
• Sorting is normally done on the File Room Order column.  The File Room 

Order column will support any filing order and can be configured or 
adjusted by your Smeadlink LDM administrator or technical support 
personnel.   

 
• Filter the report by selecting the Options button and applying a filter. 
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Hint:  The Filter feature is only used when file requests are being managed by 
multiple file rooms or filing areas. 
 
When multiple file rooms are receiving file requests, it is important that each file 
room filters the New Requests report on their current file room location.  This is a 
one time setting for each file room 
 
Select the Print Pull List button, in order to print copy of the New Requests and 
fulfill the file requests.  The printed Pull List will display a list of all files to pull, 
sorted by File Room Order. 
 

Hint:  When the report is printed, the requests will no longer appear in the 
New Request report. 
 
 
Handling Requestor Exceptions 
When files are being pulled for delivery, it is possible that some files will not be 
located.  When this happens, the request for the missing file needs to be flagged as 
an Exception.   
 
To flag a request as an Exception, run the Pull List report from the Requestor 
Reports menu.  Select the Pull List report you want to run.  You will want to 
select the pull list number on the report you are now viewing. 
 
Locate and right-click on the desired record you cannot locate and select Detail. 
 

 
 
 
 
The Detail dialog box will now display.  Select the Exception check box and enter 
details as to why this file request has been an exception. 
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From time-to-time, the File Room supervisor or personnel will want to run a 
report of current Exceptions, in order to locate the missing files.  To run the 
Exception report, select Exceptions from the Requestor Reports menu. 
 

 
 
 
Once a lost file or Exception has been located, return to the Exception report, 
right-click on the Exception, and deselect the Exception check box, then track the 
file to the requesting person. 

 
    

Requestor Audit Reports 
In order to monitor file room requesting activity and to ensure no requests go 
unfilled, Smeadlink LDM has two audit reports: 

 
In Process Report – This report will enable the file room supervisor to view all 
requests in the system, not yet fulfilled.  This report will not display reserved files 
for future delivery. 
 



S M E A D L I N K  L D M   
 

 52

Wait List Report – This report will enable the file room supervisor to view a list 
of all records that have been reserved for future delivery.  This report will give the 
file room the pulse of how many files need to be in more than one location at the 
same time.   
 

Retention Management 
Retention Management, also known as Document Lifecycle Management, is the 
management of paper and electronic records through their creation, useful active 
retrieval life, inactive storage life, to their eventual destruction or preservation, 
based on legal and operational requirements, as set forth in an organizations rules 
of retention, also known as a retention schedule.   
 
Retention management enables a business to reduce costs and reduce legal 
exposure by applying the retention status and destruction policy during creation.  
Retention Management will ensure files are moved efficiently and consistently 
from more costly active file storage space, to a less costly inactive filing area, then 
to destruction, based on the assigned retention rule and authorization from the 
department of record.  Following a retention schedule will enable organizations to 
reduce storage space requirements, reduce storage costs, and reduce legal risk. 
 
Retention schedules (Rules of Retention) are not supplied by Smead, but are the 
result of legal research performed by a records management consultant or 
attorney.  Smead recommends using a records retention specialist or consultant to 
develop specific rules of retention for your organization, based on your 
organizational record series.  Legal counsel should review and approve the rules of 
retention and your retention schedule. 
 
Retention rules are applied to records as they are created during the normal course 
of business.  When a loan record is created, or saved into Smeadlink LDM, it will 
automatically be assigned a retention code, based on the Loan Type selected for 
that loan.  Each Loan Type is assigned a default Retention Rule.  To view or 
change the default Retention Rule, select the Loan Types table from the 
Maintenance Workgroup. 
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The Default Retention Code is a lookup field, which will display all valid 
Retention Codes that have been entered into the Retention Code Maintenance 
menu.  By default, FIN5000 has been selected and has the following properties: 

• Inactivity Period – Move to Inactive Storage one year after the loan file is 
closed 

• Retention Period – Appear on Eligibility for Destruction report six years 
after the file is closed. 

 
The example Retention Rules provided in this software are used as examples in 
Smeadlink LDM.  Legal counsel must first be obtained, before using retention 
periods for records destruction. 
 
When it is time to move an active record to an inactive storage area, it will appear 
on the Inactivity Report.  Records up for destruction will automatically appear on 
the Eligible for Destruction Report. 
 
Smeadlink LDM uses event dates to trigger inactivity and destruction periods. The 
following event date options are available when defining Rules of Retention for 
both inactivity and destruction retention periods: 
 

• Date Created  
• Date Opened  
• Date Closed  
• Other Date (User Defined Date) 
• Date Last Tracked by the Smeadlink Express tracking system 
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Applying Retention to Paper and Electronic 
Records 
In Smeadlink LDM, Rules of Retention are assigned to each record by having the 
user select a Loan Type to each Loan file.  The Rule of Retention is automatically 
applied, making the assignment of Retention Codes transparent to the end user. 
 
 

 
 
 
 
 
Retention Code Maintenance 
Specific Rules of Retention are added or edited by selecting Retention Code 
Maintenance under the Retention main menu. 
 

 
 
The Retention Code Maintenance screen enables the Records Manager to enter 
inactivity and retention periods and event types, based on operational and legal 
requirements. 
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Applying Holds 
If “Hold” is selected for a given retention rule, all records which have been 
assigned to that rule will no longer be placed on the Eligibility for Destruction 
report, ensuring records will not be deleted from the system, when they are 
specifically identified an needing to be kept.   
 
Force to End Of Year 
The “Force to End of Year” check box will normally be applied.  By selecting this 
box, retention periods and eligible for destruction reports will run, as if the 
retention period were entered at the end of the year.  The “Year End” month can 
be changed to match the fiscal year of the organization. 
 
Managing Retention through Retention Reports 
In Smeadlink LDM, Retention Management is managed through the use of 
Retention Reports.  To view a list of Retention Reports, select Retention Reports 
under the Reports main menu. 
 

 
 
 
Retention Management Reports 
   
Eligible for Destruction Report 

To determine which records are eligible for destruction, select the Eligible for 
Destruction report; select New Report.   
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A report is generated and saved under a report number, so that you can rerun the 
report at a later time. 
 
The report can be sorted by clicking on the column headers, and then exporting 
or printing the report.  If you print the report, the right portion of the report will 
have a place for the department of record to approve destruction.  It is important 
to gain destruction approval before actually destroying records. 
 

 
 
 
 
Once you have gained destruction approval by the various “Record Owners,” 
rerun the report by returning to the Eligible for Destruction report, select the 
report, then the View Report button.   
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The list of eligible records for destruction will redisplay. 
 
 

 
 
 
Not all “Record Owners” may have given permission to destroy their records.  
When this happens, the user must flag which records not to destroy, before 
selecting the Destroy button. 
 
Users can prevent a record from being destroyed by placing a permanent or 
temporary hold on the individual record.  To place a hold on a specific record, 
right-click on the desired record from the Eligible for Destruction report, then 
select Detail.   
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To place a record on permanent hold, select the Item on Hold button and enter 
the reason for the permanent hold.  To place an item on temporary hold, use the 
Snooze Control feature.  Press the Snooze button once for each month you wish 
to place the record on hold.  At the end of the snooze period, the record will 
automatically reappear on the Eligible for Destruction report. 
 
 
After applicable holds have been assigned, destruction of both paper and 
electronic records, according to the approved retention policy of your 
organization can begin.  Retain a paper copy of your Eligible for Destruction 
report, as it contains the destruction approval signatures and is the source of 
evidence that records have been destroyed in the normal course of business and 
according to an approved records retention policy. 
 
Return to the Eligible for Destruct report and select Destroy.  All records not 
on hold will be flagged for destruction and will be transferred to the Certificate of 
Destruction report. 
 
   

 
 
 
 

Certificate of Destruction Report 
It is now time to destroy all paper and electronic records, which are eligible and 
approved for destruction, in the normal course of business.  
 
Select the Certificate of Destruction report from the Retention Reports menu, 
select the newest report and click on the View button to view the report. 
 



S M E A D L I N K  L D M   
 

 59

 
 
 
 
Destroying Paper Records 
Print out the Certificate of Destruction report, sign, and forward it to the person 
responsible to destroy the paper records.   
 
Destroying Electronic Records 
Select the “Del Attachments” button to destroy all electronic records appearing 
on the Certificate of Destruction list. 
 

 
 
 
 
 

Holds 
To view a list of records currently on hold, select the On Holds report from the 
Retention Reports menu. 
 
To remove the Hold status of a record, right-click on the record, select the 
Details button and remove the Hold by deselecting the Hold check box. 
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Inactive Records 
To view a list of all records ready to be moved from the Active Records File 
Room to the Inactive storage area, select Inactive Records from the Retention 
Reports menu.   
 
After the report has been sorted, run the report and collect all records ready to be 
transferred to inactive storage.  Scan the files to boxes and boxes to the inactive 
location, using the Smeadlink LDM bar code tracking feature. 
 
 

 
 
 
 
 
 
Retention Codes 
To view a list of Retention Codes (Rules of Retention) available for use, select 
Retention Codes from the Retention Reports menu.  A list of your 
organization’s Rules of Retention will be displayed. 
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Citations 
Smeadlink LDM is also capable of managing Citations.  Citations are legal 
references that backs up or justifies the use of the Retention Code.  To manage 
Citations, the Citation feature must be turned on.  Consult your Smeadlink LDM 
reseller for more information regarding Retention Management and the use of 
Citations.   
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Express Workflow for LDM 
Express Workflow is a routing and reporting productivity tool and a deficiency 
tracking tool used to enable Loan Processing Personnel and Loan Processing 
Managers to be become more efficient and effective. 
  
Loan Processing Managers will have the ability to measure productivity, ensure 
compliance, even out workloads, and foresee bottlenecks in their department’s 
loan processing activity. 
 
Loan Processors will have the ability to route work to processing workstations, 
flag problem areas, and ensure compliance by meeting critical deadlines, track 
work completed, and queue up work assigned to their workstation. 
 

Document Routing and Reporting in Smeadlink 
LDM 
Document Routing and Reporting enables a loan processing area to define the 
individual work stations, individuals, or processing areas that need to be 
completed before a loan file is complete.  Smeadlink LDM will enable users to 
route paper or electronic loan files to their defined processing areas, track when 
each loan processing step was competed, who completed the process, and allow 
users to queue up all work assigned to their processing area.   
 
Defining your Processes 
To begin defining your process, define the loan processing steps required to 
complete a loan file.  Next, select the Loan Processing Status table from the 
Maintenance Workgroup and adjust the Workflow Step and Loan Status fields to 
match your defined process.  

 

Chapter 

9 
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To add a loan process, select the New Process button and enter the name of the 
new process.  Next, enter the Workflow step, or the order in which the process 
should be competed. 
 
 

 
 
 
 

Hint:  Before entering the processing steps and processing order, it would be 
wise to first define or list the loan processing steps or processing areas on paper.  
Each time a new processing step is created, a corresponding view will be created 
in the Loans table, in order to enable users to view all Loans which are currently 
assigned to each of the defined Loan Processing Areas. 
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Using Document Routing and Reporting 
To use Document Routing and Reporting, after defining a new process, close 
Smeadlink LDM and reopen it.  This will load the Views defined in the last step. 
 
Select the Loans table from the Records Workgroup.  Select a loan record and 
click on the “Status” button.  Select which processing step the Loan should now 
be placed, then hit the OK button. 
 

 
 
 
If the user had selected “Verification” as the processing step, it means the record 
will now be displayed in the Verification work area’s work queue.   
 
Go to the View menu and select WF-Verification, to view all records currently 
need to be verified by the Verification work area. 
 
 

 
   
 
 
 

Deficiency Tracking in Smeadlink LDM 
Deficiency Tracking is the ability to track when required loan documents are 
completed and to ensure they are completed on time!  Loan files are required to 
be completed within a specific time period.  Deficiency Tracking ensures that all 
required documents are completed and will be completed on time. 
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In Smeadlink LDM, Loan Types and Document Types must first be established.  
Each Loan Type will have its own set of required documents, which must be 
completed.  Due dates are then set, which will be used to flag the user if a loan 
document is not completed before an upcoming due date.  Reports are then run to 
determine which Loans are missing required documents and which documents are 
past due or coming due soon.   
 

Hint:  Before entering Loan Types and Document Types in Smeadlink LDM, 
write down a list of Loan Types and the Documents that must be completed 
before the loan file is considered valid and complete. 
 
 
Defining your Loan Types 
Defining your Loan Types is the first step in setting up Deficiency Tracking in 
Smeadlink LDM.  To enter the defined Loan Types, select the Loan Types table 
from the Maintenance Workgroup, hit the Enter key to display all current Loan 
Types, then add the Loan Types, whose Documents you need to track completion 
and/or compliance.   
 
To complete the Loan Type record, enter the “Days Until Due” and the 
“Default Retention Code” for each Loan Type created.  The number of days 
until due is the default number of days a Loan must be completed after it was 
opened.  If the Date Due is left empty, when creating a new loan record, the Date 
Due field will default to the Opened Date + the number of Days Until Due.  The 
user can change the Date Due at any time.  The default retention code will be 
automatically applied to each Loan that is assigned to a Loan Type. 
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Defining your Document Types 
For each Loan Type entered, select a Loan Type, one-at-a-time; Select the 
Document Type hyperlink at the bottom of the screen.  Enter a list of required 
Document Types for each Loan Type.  The Document Types listed here must be 
completed for each newly added Loan record, before the Loan file will be 
considered complete. 
 
Enter an interval period when you want to ensure documents are completed 
within a specified time period before the Loan’s defined Due Date.  The Interval 
Period is the number of days the Document should be completed before the Loan 
reaches its Due Date.  If the Loan’s Due Date has the date of October 12, 2003 
and the Interval, in days, is set to 10, you will be notified on October 2nd of a 
possible compliance risk, if the document has not been completed by October 2nd.   
 
 

 
 
 
 
Using Deficiency Tracking in Smeadlink LDM 
To use Deficiency Tracking in Smeadlink LDM, select the Loans table from the 
Records Workgroup.  After entering a new Loan record in the Loans table, select 
the Loan Type and hit enter.  If Compliance dates will be tracked, either enter the 
Loan file’s Due Date or allow the system to automatically enter the Due Date, 
based on the period defined in the “Days Until Due” field of the Loan Types 
table. 
 
When documents are scanned or indexed into the system, their document status 
will be flagged as received.  When paper documents are manually placed into a 
loan file, the user must locate the Loan in the Loans table, select the Documents 
hyperlink and mark the Document as having been received.  If the document is 
only partially complete or is missing vital information, an Exception note can be 
entered into the Documents table. 
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Express Workflow Reporting in Smeadlink LDM 
Express Workflow captures reportable information when documents are routed 
and tracked for deficiency.  These reports enable loan processors or managers to 
easily gain access to information related to the loan processing activity.   
 
The following reports and available in Smeadlink LDM: 
 
Current Processing Status of a Loan 

Loan Files Queued to a specific Loan Processing Area 

Process History Report for a specific Loan 

Process History report for all Loans Processed (by a specific user in a given 

period of time) 

Missing Document Report 

Document Compliance Report 

Pipeline Report 

Productivity Report 

 
 

Current Processing Status 
The current processing status of a specific Loan can be determined from within 
the Loans table of the Records Workgroup.  Locate the record and view the 
current processing status in the Status field. 
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Processing Queue 
To view all loans queued to a specific processing area, select the View menu and 
select the Processing Queue to see all Loans currently being processed in that 
processing area.  For example, if you want to see all Loans queued for 
Verification, select the WF-Verification view. 
 
 

 
 
 
 
Process History of a Folder 
To view the processing history of a specific Loan, select the Loan file in the 
Loans table.  Select the Status History hyperlink at the bottom of the screen.   
 
 

 
 
 
Missing Document Report 
The Missing Documents Report will provide a list of all documents missing from 
all Loans currently being processed. 
 
To run the Missing Document Report, select the Documents table from the 
Records workgroup, hit the Enter key to display all loans, select Missing 
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Documents from the Reports menu, then select the Print button and select 
Formatted Reports.  
 
 

 
 
 
Compliance Report 
The Compliance Report will provide a list of all missing documents which are 
nearing their due date.  Required documents are given an interval period, which is 
the number of days the document should be completed before the Loan’s Due 
Date is reached. 
 
To run the Compliance Report, select the Documents table from the Records 
workgroup, hit the Enter key to display all records, select Compliance Tracking 
from the Reports menu, then select the Print button and select Formatted 
Reports. 
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Pipeline Report 
The Pipeline Report will provide a list of Loans currently in process and sorted by 
Loan Number.  The report will also include a list of Documents related to each 
Loan, if Deficiency Tracking is enabled.  The Pipeline Report will also list which 
Documents have been received and which Documents have flagged Exception 
notes which may require management’s attention. 
 

 
 
 
Productivity Report 
The Productivity Report will report on the productivity of the Loan Process Area, 
for a given period of time.  The report will display which Loan files were 
processed for a given day, along with who processed them and which processing 
steps were completed. 
 
To run the Productivity Report in Smeadlink LDM, select the Status History 
table from the Records Workgroup.  Next, select Productivity Report from the 
Reports menu, then select the Print button and select the Formatted Reports 
menu item. 
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